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SWITCH Deliverable Briefing Note 
 
SWITCH Document: The City Water Information System training package 
 
Deliverable reference: D1.4.5 
(Replaces D1.4.9 from the original DOW) 
Author(s) and Institution(s): Colin Schenk, Bastien Roquier, Marc Soutter / EPFL 
Publication date: 30 Apr. 2011 
Audience  
This deliverable is targeted to persons wishing to understand the City Water 
Information System by practice. 
 
Purpose 
To train the various aspects of the City Water Information System and thus to get 
an in depth understanding of what that tool actually does. 
 
Background 
Sharing information and knowledge is a very basic first step in the multi-thematic 
and multi-stakeholder global and integrated approaches that have long been 
recognized as necessary step towards a more sustainable practice of natural 
resources management. 
The City Water suite of tools and, more specifically, the City Water information 
System, have been designed to address complex strategic planning issues that are a 
major characteristic of urban water management challenges for the cities of the 
future. 
 
Potential Impact 
With its modular structure, including three complementary data viewing tools 
(reporting, geographic and systemic), its system-based database and its ability to 
handle scenario/situation data, the City Water Information System offers a unique 
tool to address complex, multi-thematic and multi-stakeholder issues in a global 
and integrated framework.  
Due to its generic layout, based on ontologies, this novel, if not revolutionary, 
Web-based information system is not restricted to integrated urban water 
management but has a very broad range of potential fields of application.  
 
Recommendations 
Try out the online demo version 
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Part A

Training the general
application infrastructure
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Access to a predefined workspace

Task1. Open the SWITCH Workspace from the Dashboard.
 Open a Web browser,
 Type your Web server address to launch the application (in the example below, the Web server
is hosted on local machine �– localhost; the demo Web server is currently located at:
http://home.ipogee.ch/DemoBmap/Bmap.html)

fig 1

 Navigate to the �“SWITCH�” dashboard item, and click on Go button. This will open the workspace
show here below, with a system view on the right side, showing the structure of the SWITCH
project and an Active Reporting Tool (ART) view on the right presenting a report on the city of
Alexandria.
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fig 2

Task2. Open the �“Getting started Workspace�” from within the application

 Reload the Web page ,
 Type your Web server address to launch the application (the demo Web server is currently
located at: http://home.ipogee.ch/DemoBmap/Bmap.html)

 Click on the open a blank workspace button (see fig.1)

fig 3
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 Collapse and expand again the Data Space section, hide and show the left panel by (i) hovering
the mouse over the upper bean like button and (ii) by clicking this button,

 Click on the Workspace tab (WS) to activate it and scroll down and click to select the Egypt
workspace,

fig 4

 Click on the open button to load and display the workspace.

fig 5
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Display views, explore projects

Task3. Open a Geo view from the View list
 Reload the application (i.e. reload the Web page) and click on open a blank workspace,
 In the Data Space expander, activate the View (V) tab,
 Scroll down to the geo view named Alexandria_Gis (if needed resize the left banner by dragging
the splitter to the right to bring the scroll in view) and position the mouse on this item,

fig 6

 Press the Ctrl Key and, while keeping this key pressed, press the right mouse button, move the
mouse into the main area and release the mouse button and the Ctrl key.

fig 7
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fig 8

Task4. Open a system view from the Alexandria Project
 In the Data Space expander, activate the Project (P) tab,
 Scroll down to the Alexandria project and expand it to see its content,
 Expand the group of system views and position the mouse on the Mariout Lake Flows view,

fig 9

 Press the Ctrl Key and, while keeping this key pressed, press the right mouse button, move the
mouse into the main area and release the mouse button and the Ctrl key.

 The selected system view replaces the previously displayed Geo view.
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fig 10

Task5. Add an ART view from the Alexandria Project to the current views and display it
 In the Data Space expander, activate the View (V) tab,
 Scroll down to and click on the Lake Mariout Report to select it,
 Add this report to the current views subset by pressing the button,

fig 11
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 Add also the Alexandria_Gis view,
 Activate the Current tab to display the subset of currently selected items and position the
mouse in the Lake Mariout Report item,

fig 12

 Press the Ctrl Key and, while keeping this key pressed, press the right mouse button, move the
mouse into the main area and release the mouse button and the Ctrl key.

 The selected art view replaces the previously displayed System view.

Create a new project with a view and a workspace, and save it

Task6. Create a new project and name it
 Press the right most button in the group of three button located on the top left part of the
view: this will close the view�’s display,

 In the Data Space expander, activate the Project tab (P),
 Open the Add New... expander, and position the mouse on the project element,
 Press the Ctrl Key and, while keeping this key pressed, press the right mouse button, move the
mouse into the Project tab and release the mouse button and the Ctrl key,

 A new project, named New Project has been added to the list,
 Open the New Project expander, click in the name field to edit its content and change the
project name to �“My Project�” for example,
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fig 13

Task7. Add a newWorkspace to the project
 Ctrl Drag the Workspace item from the Add New... section onto My Project View, drop it (i.e.
release the mouse button) while pressing additionally the Shift Key (Ctrl Key remains pressed),
this will create a new group of Workspaces in My Project,

 Do the same operation again: Ctrl Drag the Workspace item from the Add New... section and
drop it onto the just created group of Workspaces, this will add a newWorkspace in the new
group of Workspaces of My Project,

Task8. Add a new Geo View to the project
 Ctrl Drag the Geographic view item from the Add New... section onto My Project View, drop it
(i.e. release the mouse button) while pressing additionally the Shift Key (Ctrl Key remains
pressed), this will create a new group of Geographic views in My Project,

 Do the same operation again: Ctrl Drag the Geographic view item from the Add New... section
and drop it onto the just created group of Geographic views, this will add a new Geo view in the
Geo View Group of My Project,
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fig 14

 Ctrl Drag the new Geo View and drop it in the display area,
 Zoom in, towards the city of Yverdon les Bains in western Switzerland,

fig 15
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Task9. Save these changes
 Activate the View tab, select the new Geo View and click the save button,

fig 16

 Activate the Workspace tab, select the new Workspace and click the save button, this
workspace will store the actual view and layout pretty much as a screenshot,

fig 17

 Activate the Project tab, select My Project and click the save button,
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Explore andmanipulate the layout, switch views

Task10. Watch the �“Help�” window while moving onto different elements of the layout
 Reload the application and click on open a blank workspace,
 Position the mouse successively in various parts the screen and have a look at the help
messages displayed in the �“Help window�” located at the bottom of the application�’s general left
banner,

fig 18

Task11. Split the layout, switch views,
 In the Layout Manager Expander, click on the Two Window button,
 Open the Data Space View tab and, as described previously (with the ctrl key pressed), drag the
Alexandria_Gis view and drop it in the left window and then drag the Lake Instantiation view
and drop it in the right window,
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fig 19

 Notice that each of these views does have a colored tag as the central button of the group of
three buttons located on the top left part of the view, and that the same colored tag is also to
be found in the list of views for the corresponding item,

 As should have now become familiar, Ctrl drag the colored tag of the Alexandria_Gis view and
drop it on the Lake Instantiation view: the two views have been switched in the display,

fig 20
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Task12. Resize parts of the display.
 Click on the right most button of the group of three buttons located on the top left part of the
Lake Instantiation view: this will close the display of that view,

 Ctrl drag the colored tag of the Alexandria_Gis view and drop it on the left, now empty,
window: The Alexandria_Gis view is moved back to the left most display area,

 Click on the separation between the two available display areas and, keeping the mouse button
pressed, move the mouse to the right to increase the size of the left display area.

fig 21

fig 22
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fig 23



Part B

Training the geographic
module (GEO)



Manipulate a GEO view

Task1. Panning and zooming, using the mini map.
 Open the Alexandria_Gis Geo view, hide the main left banner and show the Geo View�’s left
banner,

 Enlarge the mini map area by dragging its bottom right button,
 Move the map (or the mini map) around with the left mouse button pressed, the red area in the
mini map matches the area covered by the main map,

 In the mini map, move the red square around with the left mouse button pressed: the area
shown in the main map is updated accordingly,

 Use the mouse scroll button to zoom in and out, on the main map or on the mini map,
 Double click on the mini map drag button, to hide the mini map and show it again,
 Show and hide the Geo view�’s left panel by (i) hovering the mouse over the lower bean like
button and (ii) by clicking this button,

 Expand the name expander in the geo view�’s left banner to change the view�’s name and provide
a short description

fig 24

Task2. Change the background layer, modify its transparency
 Change the background map using the bottom right list: explore various type of maps, terrains,
or satellite imagery, including Bing�’s Bird�’s eye and Street Side (currently mostly efficient over
the US),

 Right Click on the mini map to change its background map type,
 Learn to change the background map�’s transparency using the bottom right slider.



fig 25

fig 26



fig 27

fig 28



Show and configure data layers, layer overlay order

Task3. Display a data layer
 Open the Alexandria_Gis Geo view, hide the main left banner and show the Geo View�’s left
banner,

 In the left banner, expand the Data Layer section,
 Click on the check boxes of the Alexandria Governorate and the Nile river to display these layers
on the map,

fig 29

Task4. Configure a data layer
 Click to expand the Alexandria Governorate layer item to gain access to its fill and stroke
settings,

 Change the polygon�’s background color to orange and decrease its opacity,
 Click to expand the Nile river layer item to gain access to its fill and stroke settings,
 Change the polygon�’s border color to blue and increase its thickness.



fig 30

fig 31

Task5. Modify overlay order
 Click on the check box of the Canals and the Mini Clusters layers to add them to the map: note
that the layers are added on top of the map,



fig 32

 In the left banner, expand the Layer Overlay section,
 Select the Alexandria Governorate layer, use the buttons to bring it on top of the map,

fig 33

 Use the buttons to set a correct overlay order and change the overall transparency of the
Alexandria Governorate layer, hide the Nile river layer.



fig 34

Create and configure an indicator layer

Task6. Create an indicator layer
 In the left banner, expand the indicator section,
 Display the MC + indicators layer and wait until the �“Geo layer complementary data loaded
properly�” message is displayed in the message bar,

 Ctrl Drag the MC + Indicators data layer and drop it in the indicator section: a new indicator
layer is created,

fig 35



 Change the layer name to �“Indicator Test�”, zoom slightly in, and decrease the background map�’s
opacity

fig 36

Task7. Configure indicator layer

 Click on the layer to open its configuration panel,
 Select the indicator to display,

fig 37



 Click on the layer to open its configuration panel,
 Change the rounding level to 2 and observe the effect it has on the map and the class limits

fig 38

 Switch the distribution type to �“equal counts�” and change the start color of the color ramp to
orange.

fig 39



Edit the geometries

Task8. Select/Edit a shape
 Display the Lakes layer and hide the other layers ,
 Right Click on a shape to access to its contextual menu and choose the Select Shapemenu item,

fig 40

 The selected shape appears highlighted. Right click on the selected shape and choose the
Unselect Shapemenu item,

fig 41



 Edit the shape geometry by a Right Clicking and choosing the Start Editing Shape contextual
menu item,

fig 42

 The vertices of the shape are displayed.

fig 43



 Zoom in, position the mouse on the edge of the shape, and Right Click again: in the contextual
menu choose Add Vertex to add a new point to the shape,

fig 44

 Place the mouse on this new vertex and, with the left button pressed, move the new point to
another location,

fig 45



 To remove a vertex, Right Click on it and select Delete Vertex,

fig 46

 Once the changes are made, quit the edition mode by Right Clicking on the edit shape and
choosing Stop Editing Shape,

fig 47



Task9. Add/delete shapes
 In the left banner, expand the Edition Mode section, select the layer to be edited (Lakes in our
example) and choose the type of element to add (point, polyline or polygon),

 With the Add Pointmode selected, each click on the map will add a new point,

fig 48

 With the Add Polylinemode selected, each click on the map will add a point to a new polyline.
Double click on the last vertex to quit the point addition mode,

fig 49



 With the Add Polygonmode selected, each click on the map will add a point to a new polygon.
Double click on the last vertex to quit the point addition mode,

fig 50

 All these shapes may be deleted with the appropriate contextual menu item: Right Click on the
shape and select the Delete Shapemenu item.

Managing Situations in a Geo View

Task10. Create a new situation
 Activate the general left banner, open the Project manager and Data Spaces section, activate
the Situation tab (S). If the base situation is the only situation listed, expand the Add New...
section, Crtl Drag the Situation item and drop it in the Situation tab to create a new situation,

 Add the existing alternative Situations or the new Situation among the Current items: select
them and press the blue arrow button,

Task11. Assign a shape to an alternative situation
 Back in the Geo Viewer, display the Lake layer,
 Right Click on a shape in this layer to access its contextual menu and modify the shape�’s
situation memberships: remove it from the base situation and add it to an alternative situation
(Situation 1 in our example). This shape appears dimmed since its no more part of the active
Situation but belongs to the visible but not active Situation1.



Task12. Explore the principles of situation management in the Geographic view
 In the situation manager, set Situation1 as invisible: all items that do not belong to a visible
situation are hidden,



 In the situation manager, set Situation1 back as visible and active: the shapes that belong to the
Base Situation are still visible but dimmed,

 In the situation manager, set the Base Situation as invisible: the shapes that belong to the base
situation are hidden,



Part C

Training the Active
Reporting Tool (ART)
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Search for a system element and display its data and reports

Task1. Search for a system element and display its data and report
 Launch the application and open a blank workspace,
 Expand the Data Space and the Add New... section,
 Ctrl Drag an Active Report view and drop it in the display area.

fig 51

 Open the search tool, the By Name search is active, type �“Alexandria�” as the Element Name to
look for, validate the request to launch the search,

fig 52
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 Among the obtained results, Ctrl Drag the Alexandria Learning Alliance item and drop it in the
display area,

fig 53

 The following report sheet will open:

fig 54
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Task2. Explore the three data panels
 On the top left side of the display area, there is a group of commands allowing to switch
between several viewing modes of the three components of an Active Report View, i.e. to see
the attributes section alone [a], the report section alone [r], the data section alone [d], the
report section along with the data section [r|d]. The see the all of them together click on the
item marked as [3],

fig 55

 Click on [r] to get back the report alone. The report area may contain several report sheets. In
our example, there is one report specific for Alexandria and a second report sheet that describes
the SWITCH learning alliances in general and is actually inherited by all �“children�” of the
�“Learning Alliance Class�” (see Part D and Part E). Click on the Learning Alliance tab to see this
report,
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fig 56

Task3. Navigate using hyperlinks
 This report contains two links to external websites and one internal hyperlink, directed to an
element described as SWITCH Cities, Click on that link to open that other report,

fig 57

 As can be seen above, the report view can host the reports related to different elements, each
of them hosting possible several reports,

 Click on the internal link to Alexandria to add the corresponding report to the current collection
displayed in the Active Report view,
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fig 58

 Click on the Web link displayed in the Alexandria report to access to the related Web site,

fig 59
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Add and edit data

Task4. Add an image
 Activate the application�’s left banner to access the project section, and, from the Alexandria
project, Ctrl Drag the Marriout Lake report and drop it in the display area,

fig 60

 Press the [d] button to look at the data section alone,

fig 61
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 Select the Salted Water Inflow tab, and press the Add button to enter a new value, with
appropriate units and validity start,

fig 62

Task5. Add a new image
 Switch to the Images tab, and press the Add button, this adds a new image item with no data,

fig 63
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 To upload an image for this new item, Click in the image field, and select the add button that
appears there,

fig 64

 Then browse to the folder where you store the image you want to upload, and select the image,

fig 65
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 The selected image is now ready for use (see next section)

fig 66

Task6. Edit and modify the URL address of a Web Site
 The Lake Mariout element doesn�’t have an information group (or attribute) designed to host a
Web Site address. The way in which such an item can be added will be trained in section E, for
the time being let�’s just switch to another report sheet that hosts a Web link: use the search toll
to find and display the Alexandria report,

fig 67
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 The Lake Mariout element doesn�’t have an information group (or attribute) designed to host a
Web Site address. The way in which such an item can be added will be trained in section D, for
the time being let�’s just switch to another report sheet that hosts a Web link: use the search toll
to find and display the Switch Cities report again,

fig 68

 Switching to the data section gives access to the Web Site group where a new web site can be
added

fig 69



City Water Information System �– Training material 49

Create a new report

Task7. Add a new report sheet
 Display the Mariout lake report again,

fig 70

 Click on the Add button to add a new empty report sheet,

fig 71
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Task8. Add a title and some text
 Change the report name in the report�’s name area, click on the Edit button to switch to the
edition mode (signalled by a red border), type a new title,

fig 72

 Get some descriptive information,

fig 73
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 Copy and paste the selected text,

fig 74

Task9. Add an image
 Click on the [r|d] button to activate both the report and the data section, select the Images tab
and Ctrl Drag the penguin image to drop it in the report,

fig 75
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 To handle layout issues such as the image size, one has to edit the report sheet background tags,
so Click on the Edit Tags button

fig 76

 Click on the Left to Right Arrow to update the tags from the report, change the image Height
property to 200 (see htt) and click the Right to Left Arrow to update the report from the tags.

fig 77
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Task10. Add some numeric data as a static or dynamic element
 To add a numeric value in the report, repeat the same procedure, i.e. Ctrl Drag the numerical
item into the report sheet,

fig 78

 As can be seen by changing the numerical value in the data section, the report is automatically
updated,

fig 79



Part D

Training the System
module
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Adding elements from the element libraries Nodes
Task1. Add a new watershed

 Launch the application and open a blank workspace,
 Expand the Data Space and the Add New... section,
 Ctrl Drag an Active Report view and drop it in the display area.

fig 80

 Expand the Node section of the Classes library,
 Ctrl Drag a Watershed Node and drop it in the display area,
 Double Click its name to edit and change it,

fig 81
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Task2. Add a new group of watershed
 Ctrl Drag a Watershed Node and drop it in the display area with the Shift key also pressed to
add a group of watersheds,

fig 82

Task3. Connect the watershed as a member of the watershed group
 Expand the Connections Library, Ctrl Drag and Drop a Group Member connection,

fig 83
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 Select the connection (drawing a selection square might be easier than clicking on the object) ad
connect its extremities to the Group and Group member,

fig 84

fig 85
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Task4. Add the parent class and the appropriate instantiation connections
 Ctrl Drag a Watershed Node and drop it in the display area with the Alt key also pressed to add
the Watershed class, which is the abstract �“parent�” of both the watershed Node and
NodeGroup,

fig 86

 As maybe noticed the instantiation connections are automatically added,
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Adding elements from the element libraries Information

Task5. Add a new property to the watershed
 Expand the Information section of the Classes Library, Ctrl Drag and Drop a Inhabitants item.
This will add a group of information designed to host data on the number of inhabitants in the
watershed ,

fig 87

 Expand the Connections Library and Ctrl Drag and Drop a Property connection,

fig 88
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 Using this Property connection, connect the inhabitants information group as a property of the
watershed,

fig 89

Task6. Add the information parent class and the appropriate instantiation connection
 Ctrl Drag an Inhabitants information class and drop it in the display area with the Alt key also
pressed to add this parent class to the display,

fig 90
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Adding elements from the element libraries Interactions

Task7. Add a water flux between the two watersheds
 Add a second watershed and rename it, and add a Group member connection (same procedure
as for the first watershed),

fig 91

 Expand the Interaction section of the Class Library, Ctrl Drag and Drop aWater Flux interaction,

fig 92
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 To link the two watersheds in terms of water flux leaving one to enter the other, one has to add
the appropriate information groups as showed below,

fig 93

 In that case again, the display can be completed by adding the interaction�’s parent class,

fig 94

 Ctrl Drag an Inhabitants information class and drop it in the display area with the Alt key also
pressed to add this parent class to the display,
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Adding data to document these new elements

Task8. Add the parent classes and the appropriate instantiation connections
 Split the display into two windows and add a new report view in the right display area, Ctrl Drag
theMyWatershed item from the System view (left part of the display) to the Report view (right
part of the display),

fig 95

 As can be seen the data section has two tabs, respectively for the inhabitants and outgoing
water fluxes. Remembering the case of Lake Marriout Report where no information group was
designed to host Web site information, it appears that exposing this item in a system view
allows adding the required information group.
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fig 96

Create a diagram using the exploration mode

Task9. Explore the data according to the systems logic
 Start from a new empty system view,
 Use the search tool to find the SWITCH project,
 Ctrl Drag and Drop it from the search results list and drop it in the display area, if needed resize
the icon to something reasonable,

fig 97
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 Activate the exploration mode in the navigation section of the left banner: the existing SWITCH
project item gets dimmed, while the connect elements are displayed,

fig 98

 Right Click on the items you wish to add to the system view, here the Learning Alliances group,
the SWITCH Cities group and the SWITCH Partners group,

fig 99



City Water Information System �– Training material 66

 Deactivate the exploration mode, the new current system layout is displayed,

fig 100

 Same procedure to explore the SWITCH Cities and add the City of Alexandria to the display,
exploring the connected elements,

fig 101
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 �“Materializing�” the Alexandria element,

fig 102

 Deactivating the exploration mode,

fig 103
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 Same procedure to explore the Alexandria element,

fig 104

 Adding the group of Decision Making Teams and the Waterbodies,

fig 105
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 To see that the Alexandria Learning Alliance belongs to the Decision Making Teams in
Alexandria and at also to the group of Learning Alliances that are a property of the SWITCH
project,

fig 106

 Finally one might add some elements linked to the Alexandria Learning Alliance Activities, and
so on...

fig 107
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Managing Situations in a System View

Task10. Create a new situation
 Activate the general left banner, open the Project manager and Data Spaces section, and
activate the Situation tab (S). If the base situation is the only situation listed, expand the Add
New... section, Crtl Drag the Situation item and drop it in the Situation tab to create a new
situation,

 Add the existing alternative Situations or the new Situation among the Current items: select
them and press the blue arrow button,

Task11. Assign a system element to an alternative situation
 Back in the System Viewer, display the Lake Instantiation View,
 Right Click on a group of information to access its contextual menu and modify the it�’s situation
memberships: remove it from the base situation and add it to an alternative situation (Situation
1 in our example). This element appears dimmed since its no more part of the active Situation
but belongs to the visible but not active Situation1.

Task12. Explore the principles of situation management in the System view
 In the situation manager, set Situation1 as invisible: all items that do not belong to a visible
situation are hidden,
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 In the situation manager, set Situation1 back as visible and active: the items that belong to the
Base Situation are still visible but dimmed,
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 In the situation manager, set the Base Situation as invisible: the items that belong to the base
situation are hidden,



Part E

Combined exercises



Using the view synchronisation

Task1. Synchronise three views
 Split the layout in four region and resize the Top Right area down to the bottom of the display
area. Add the Alexandria_Gis Geo view, the Lake Marriout Flows System View and a new ART
view.

 Synchronize the three views by a Ctrl Drag of the S button (left most button of the view�’s top
right toolbar) from one view to the others. When synchronised, the three views display the
same color tag in their S button.



 Alternatively select and deselect Lake Marriout in the System view, and in the Geo View. Search
for Lake Marriout in the ART view�’s search tool and drop it into the view�’s display area. You may
see that in each of these situations the selections are automatically updated in the two other
views.

Using the drag/drop between views

Task2. Drag System elements from one view to drop them into another view
 Split the layout in two regions, and add the Alexandria_Gis Geo view and a new ART view.
 Ctrl Drag and Drop Lake Marriout from the Geo View in to the Art view

 Do the same operation with a new System View instead of the ART View. The same drag and
drop operation may also be used between a System View and an ART View.



Using the system view to add new properties

Task3. Drag System elements from one view to drop them into another view
 It can be remembered that, while editing data for Lake Marriout, it was not possible to add a
web site address because there was no such information group available (Task6 of section B).
Actually one may use a System View to modify the Lake Marriout�’s related data structure to add
the required information group. Do the following:

 Split the layout in two regions, and add a new System View and a new ART view,
 In the System View search for Lake Marriout and add this item to the View,
 Ctrl Drag Lake Marriout�’s system element and drop it into the ART View, and there activate the
data section,

 Use the exploration mode to see Lake Marriout�’s the related information groups and add them
to the display,



 In the System View, add a new information group of the WebSite type and connect it to Lake
Marriout,



 In the ART View you can now add an URL address in the Data section.


